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INSTALLATION GUIDE

BNC-2096

The BNC-2096 is a 16-channel rack-mount adapter for reading
IEEE P1451.4 Transducer Electronic Data Sheet (TEDS) information
from Class I TEDS sensors.

The BNC-2096 has the following features:
e 16 TEDS-capable input channels

*  E Series data acquisition (DAQ) device control through a 68-pin
connector

e NI4021 control through a 10-pin auxiliary (AUX) connector

e 10-pin pass-through AUX connector for digital control of multiple
BNC-2096 devices with one control device

*  External power option

e 5-bit addressing for using multiple adapters

* 19 in. rack-mount housing

e Software support with a LabVIEW TEDS VI library

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

<> Angle brackets that contain numbers separated by an ellipsis represent
arange of values associated with a bit or signal name—for example,
Al<0..7>.
E This icon denotes a note, which alerts you to important information.
A This icon denotes a caution, which advises you of precautions to take to

avoid injury, data loss, or a system crash. When this symbol is marked on
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the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

bold Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

italic Italic text denotes variables, emphasis, a cross reference, a hardware label,

or an introduction to a key concept. This font also denotes text that is a
placeholder for a word or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

What You Need to Get Started

To set up and use the BNC-2096, you need the following items:

U Software
—  NI-DAQmx 7.2 or later for Windows 2000/NT/XP

U Hardware
— BNC-2096
—  68-pin E Series device or NI 4021

— NI 447X or NI PXI-4461 Dynamic Signal Acquisition (DSA)
device, or SCXI subsystem with SCXI-153X!

—  One or more Class I TEDS sensors for TEDS capability

—  BNC-2096 external power adapter (if using more than
one BNC-2096)

U Documentation
—  BNC-2096 Installation Guide
—  Read Me First: Safety and Radio-Frequency Interference

—  E Series, NI 447X, NI PXI-4461, SCXI-153X, or NI 4021
documentation

—  DAQ Quick Start Guide

! Although any DAQ device with BNC connectivity can read the analog sensor data from the BNC-2096, NI recommends using
devices designed for maximum sensitivity and dynamic range when measuring signals from microphones and accelerometers
such as the NI 447X, SCXI-153X, and NI PXI-4461.
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U Tools

1/8 in. flathead screwdriver

U Cables

68-pin cable or AUX cable
BNC-to-BNC cables

BNC-to-SMB cables (for use with the NI 447X)

If you do not have NI-DAQmx 7.2 or later, or one of the documents, you
can download them from ni . com, or contact an NI sales representative.

TEDS Related Information

You can find more TEDS information in the following locations:

© National Instruments Corporation

Measurement & Automation Explorer Help for NI-DAQmx and

NI-DAQmx Help

ni.com/info and enter any of the following info codes:

rdsenr
rdpnpy
rdpnsn
rdted6

rdrscl
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Theory of Operation

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires. Refer to
the Specifications section for important safety and compliance information

Figure 1 shows the BNC-2096 and important locations on the adapter.

cns

BNC Row FROM IEPE SENSOR
Power Source Selection Switch
External Power Source Plug
Address DIP Switches

68-pin Connector for E Series Control Device
AUX Connector for NI 4021 Control Device
AUX Connector to Next BNC-2096

BNC Row TO IEPE Al DEVICE

SO =

w0 ~NOo O

Figure 1. BNC-2096 Parts Location Diagram
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Figure 2 diagrams the operation of the BNC-2096.

TEDS
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o | FromIEPE|
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Switch EXT :
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Settings | !

v :

Logic :

Circuitry :

v 5
. < : Control
<—»| Microcontroller : > Device

Figure 2. BNC-2096 Operational Block Diagram

The BNC-2096 uses a microcontroller to communicate to the TEDS sensor.
The BNC-2096 interfaces with a TEDS Class I sensor as part of a data
acquisition system. This system includes TEDS sensors, a control device,
one or more BNC-2096 adapters, and one or more analog input (AI)
devices. The control device acts as the master device and handles all of the
configuration requests between the BNC-2096, Al device, and the TEDS
sensor. The BNC-2096 acts as the slave device by accepting commands
from the control device and setting the correct channel mode, as well as
interfacing with the TEDS sensor. The Al device measures the physical

sensor signal.

@ Note You can use Virtual TEDS sensors along with TEDS sensors as part of the
measurement system. The BNC-2096 passes the data directly to the acquisition device.
For more information about Virtual TEDS go to ni.com/sensors.

© National Instruments Corporation

BNC-2096 Installation Guide



The BNC-2096 has two modes of operation: analog pass-through and
TEDS mode. The default channel status of all channels on the BNC-2096
is analog pass-through. While in analog pass-through mode the BNC-2096
passes the analog signal between the TEDS sensor and an analog channel
on the Al device.

When a sensor is asked by a software command to send digital TEDS data
back to the control device, the channel status is changed to TEDS mode.
This mode allows the TEDS sensor to send and receive data. Once the
sensor sends the data to the control device the channel switches back to
analog mode. When the BNC-2096 returns to analog mode you can acquire
a signal from the sensor again. While the TEDS sensor is in TEDS mode
the analog channel is disconnected and you cannot acquire a valid signal
with the Al device.

Note NI recommends stopping all analog acquisitions before switching any channel to

TEDS mode.

Figure 3 diagrams the TEDS modes and how they affect the BNC-2096.

TEDS Sensor

TEDS Digital Mode

Digital
TEDS

Analog
Accelerometer
Signal

Analog Signal

N N TEDS Digital Data N o— Digitizer
— Reference — O\o_ Digital Data
Controller/Reader

TEDS Sensor

.................................................................

Digital
TEDS

Analog
Accelerometer
Signal

/ - Reference ~

Analog Signal

Digital Data

Controller/Reader

" Analog Signal R O/o— Digitizer ;
o—]| 5
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Figure 3. Analog and Digital Modes of Operation
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Addressing the BNC-2096

You can connect up to eight BNC-2096 adapters to one control device with
the AUX connectors and external power adapters. Each BNC-2096 is
assigned a unique address and each channel is addressed sequentially. You
can set the BNC-2096 address with a series of DIP switches on the back of
the adapter. Refer to Figure 1 for the location of the DIP switches.

@ Note The address data is binary. To select address 19, for example, you must set switches

4 and 3 to the OFF position.

Refer to Figure 4 for an example of how to use the address DIP switches.

—

=0
=

ON =

Chassis Default
Address =0

- NDWhrhO

0\ |

=

0

ON =«

Address = 19

“NDWhrhO

Figure 4. Address Setting Examples

You can only power one BNC-2096 with the control device. You must
connect the external power adapter to each additional BNC-2096.

Connecting Signals

This section describes how to connect signals to the BNC-2096 and other
necessary components of the measurement system. Figure 5 shows an
example of a measurement system with the BNC-2096 and NI 447X Al

devices.

© National Instruments Corporation 7
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1 |EPE Sensors 4 NI 447 X for Measuring Channels <8..15>
2 Control Device 5 NI 447X for Measuring Channels <0..7>
3 BNC-2096

Figure 5. Connecting the BNC-2096

To connect the BNC-2096 refer to Figures 1 and 5 and complete the
following steps:

1. Use either a 68-pin or an AUX cable to connect the control device to
the appropriate connector on the back of the BNC-2096.

2. If you are connecting multiple BNC-2096 adapters to one control
device, connect an AUX cable to the connector labeled 7O NEXT AUX
DEVICE on the previous BNC-2096 to the connector labeled FROM
AUX CONTROL DEVICE on the next BNC-2096.
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@ Note You may connect up to eight BNC-2096 adapters to one control device. Ensure that
each BNC-2096 has a different address. You also must connect every BNC-2096 not
connected to the control device to external power with the supplied adapter.

3. Using a male BNC-ended cable, connect an IEPE sensor to one of
the BNC connectors CH<O0..15> on the row labeled FROM IEPE
SENSOR.

4. Using a male BNC-ended cable, connect the Al device to one of the
BNC connectors CH<O0..15> on the row labeled TO IEPE Al DEVICE.

@ Note Figure 5 uses two eight-channel NI 447X devices as an example of how you can
connect two Al devices to read up to 16 channels through the BNC-2096.

Specifications

This section lists the specifications for the BNC-2096. These specifications
are typical at 25 °C unless otherwise stated.

Analog Input

Sensor compatibility .......ccccceecveervennenne IEEE P1451.4 Class I

Input channels .........ccccoocevineeninnnenen. 16

Maximum input voltage .........c..ccecceueenee. Each input should remain within
+42.4 VDC (30 V) of any other
input or of Al GND

Crosstalk (any combination of channels 0 to 7) from f;; = 0 to 51.2 kHz

Shorted INPut......ccceeveeeeeieerennenne. <-90 dB

1 KQload....c.ccocveveeveiinieiieecene <-75dB
Maximum cable length........................... 61 m (200 ft), typical
External addressing.........ccceeeeevveenieeneene 23 software valid addresses

Maximum BNC-2096 per controller...... 8

Power Requirement

Physical

Dimensions.........ccoeceeeveeriernieenieeneeneenn 48.3 by 4.4 by 18.8 cm
(19.0 by 1.7 by 7.4 in.)
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1/0 Connectors

1/0O connections...........eeceevvuveeeeeeninveeeeennns 32 BNC connectors

E Series control device connection......... 68-pin 0.8 VHDCI

AUX connector..........ccceevevueiieniiiieniens 9-pin DIN
Environmental
Operating temperature .............ceceeeueenee. 0to50°C
Storage temperature .........eecveeveerveerneennne -55to0 50 °C
Relative humidity ........cccceevvveviiieniennennns 5% to 90%, noncondensing
AU ..o 2,000 m (at 25 °C ambient
temperature)
Pollution Degree (indoor use only) ........ 2
Safety
The BNC-2096 is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:
e« JEC61010-1, EN 61010-1
e UL3111-1, UL 61010B-1
+ CAN/CSA C22.2 No. 1010.1
@ Note For UL and other safety certifications, refer to the product label, or visit

ni.com/hardref.nsf, search by model number or product line, and click the
appropriate link in the Certification column.

Electromagnetic Compatibility

EmiSSionsS........cccoovviviviieiciiieieeeeeeeeeeeeen. EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMMUNILY oo, EN 61326:1997 + A2:2001,
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.
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CE Compliance
The BNC-2096 meets the essential requirements of applicable European

Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety) ............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMC) ...ccooveevevvenininineee 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/hardref .nsf, search by model number or product line, and click the
appropriate link in the Certification column.

Technical Support Resources

NI Web Support

National Instruments Web support is your first stop for help in solving
installation, configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni . com.

Worldwide Support

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. You can access our branch office Web sites
from the Worldwide Offices section of ni . com. Branch office Web sites
provide up-to-date contact information, support phone numbers, email
addresses, and current events.

If you have searched the technical support resources on our Web site

and still cannot find the answers you need, contact your local office or
National Instruments corporate. For telephone support in the United States,
dial 512 795 8248. For telephone support outside the United States, contact
your local branch office:

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, Belgium 32 0 2 757 00 20,
Brazil 55 11 3262 3599, Canada (Calgary) 403 274 9391,

Canada (Ottawa) 613 233 5949, Canada (Québec) 450 510 3055,

Canada (Toronto) 905 785 0085, Canada (Vancouver) 514 685 7530,

China 86 21 6555 7838, Czech Republic 420 224 235 774,
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Denmark 45 45 76 26 00, Finland 385 0 9 725 725 11, France 33 0 1 48 14 24 24,
Germany 49 0 89 741 31 30, Greece 30 2 10 42 96 427, India 91 80 51190000,
Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970,

Korea 82 02 3451 3400, Malaysia 603 9131 0918, Mexico 001 800 010 0793,
Netherlands 31 0 348 433 466, New Zealand 0800 553 322,

Norway 47 0 66 90 76 60, Poland 48 22 3390150, Portugal 351 210 311 210,
Russia 7 095 783 68 51, Singapore 65 6226 5886, Slovenia 386 3 425 4200,
South Africa 27 0 11 805 8197, Spain 34 91 640 0085, Sweden 46 0 8 587 895 00,
Switzerland 41 56 200 51 51, Taiwan 886 2 2528 7227, Thailand 662 992 7519,
United Kingdom 44 0 1635 523545

LabVIEW™, National Instruments™, NI™, ni.com™, NI-DAQ™, and SCXI™ are trademarks of
National Instruments Corporation. Product and company names mentioned herein are trademarks or
trade names of their respective companies. For patents covering National Instruments products, refer

to the appropriate location: Help»Patents in your software, the patents. txt file on your CD, or
ni.com/patents.
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© 2004 National Instruments Corp. All rights reserved.



	BNC-2096 Installation Guide
	Conventions
	What You Need to Get Started
	TEDS Related Information
	Theory of Operation
	Figure 1. BNC-2096 Parts Location Diagram
	Figure 2. BNC-2096 Operational Block Diagram
	Figure 3. Analog and Digital Modes of Operation
	Addressing the BNC-2096
	Figure 4. Address Setting Examples


	Connecting Signals
	Figure 5. Connecting the BNC-2096

	Specifications
	Analog Input
	Power Requirement
	Physical
	I/O Connectors
	Environmental
	Safety
	Electromagnetic Compatibility
	CE Compliance

	Technical Support Resources
	NI Web Support
	Worldwide Support


